Legal Information

Copyright ©1994 - 2007 Sonic Solutions. All Rights reserved. Use of this product is subject to your agreement to all of the terms of each of the license agreements included in this package.

Trademarks

Fit-to-DVD is a trademark owned by Sonic Solutions which may be registered in some jurisdictions. Popcorn, Toast, ToastAnyWhere, the toaster with discs logo, Sonic, Sonic Solutions, Roxio, the Roxio logo, and the burning CD logo are registered trademarks owned by Sonic Solutions in the United States and/or other countries. This product may be protected by one or more of the patents listed at www.sonic.com/innovation/patents.

Third-party trademarks and technologies

The Mac logo, Mac, Macintosh, iPod, iPhone, Apple TV, Mac OS, Final Cut, iTunes, iMovie, iDVD, DVD Studio Pro, and QuickTime are trademarks of Apple Computer, Inc. registered in the U.S. and other countries. Bonjour is a trademark of Apple Computer, Inc.

PSP, PlayStation 3, and Memory Stick are trademarks of Sony Computer Entertainment, Inc.

Palm and Treo are among the trademarks or registered trademarks owned by or licensed to Palm, Inc.

The RIM and BlackBerry families of related marks, images, and symbols are the exclusive properties of and trademarks or registered trademarks of Research in Motion Limited - used by permission.

Turbo.264, EyeTV and the EyeTV logo are registered trademarks of Elgato Systems.

Portions of this software © 2007 TiVo Inc. TiVo and the TiVo logo are registered trademarks of TiVo Inc. or its subsidiaries.

This product uses the LAME MP3 Encoder library (the “Library”). The Library is licensed under the GNU Library General Public License, Version 2, 1991. For a copy of the complete corresponding machine-readable source code for the Library, send your request to Sonic Solutions, 101 Rowland, Suite 110, Novato, CA 94945 Attn: Legal Department. Processing, shipping, and handling charges will apply.

‘Dolby’ and the double-D symbol are trademarks of Dolby Laboratories.

This product contains one or more programs protected under international and U.S. copyright laws as unpublished works. They are confidential and proprietary to Dolby Laboratories. Their reproduction or disclosure, in whole or in part, or the production of derivative works therefrom
Changes

The material in this document is for information purposes only and is subject to change without notice. While reasonable efforts have been made in the preparation of this document to assure its accuracy, Sonic Solutions assumes no liability resulting from errors or omissions in this document, nor from the use of the information contained herein.

Sonic Solutions reserves the right to make changes in the product design without reservation and without notification to its users.
Disclaimer

THIS PRODUCT DOES NOT BYPASS OR CIRCUMVENT COPY PROTECTION. THIS PRODUCT DOES NOT ENABLE YOU TO COPY DVDs CONTAINING CSS-ENCRYPTION OR OTHER COPY-PROTECTED CONTENT. IF THIS PRODUCT ALLOWS YOU TO COPY ANY CONTENT, YOU MAY DO SO ONLY IF YOU OWN THE COPYRIGHT, YOU HAVE OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT OWNER, OR YOU HAVE THE LEGAL RIGHT TO MAKE SUCH A COPY. IF YOU ARE NOT THE COPYRIGHT OWNER OR YOU HAVE NOT OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT OWNER, YOU MAY BE VIOLATING COPYRIGHT AND OTHER LAWS AND YOU MAY BE SUBJECT TO CLAIMS FOR DAMAGES AND/OR CRIMINAL PENALTIES. ANY ILLEGAL USE OF THIS PRODUCT IS STRICTLY PROHIBITED. IF YOU ARE UNCERTAIN ABOUT YOUR RIGHTS, YOU SHOULD CONTACT YOUR LEGAL ADVISOR. YOU ASSUME FULL RESPONSIBILITY FOR THE LEGAL AND RESPONSIBLE USE OF THIS PRODUCT.
Contents

What is Popcorn? .............................................2
System requirements .....................................2
Installing Popcorn .......................................3
Getting to know the Popcorn window .................4
What types of video can Popcorn use? ...............5
Popcorn Extras.............................................6
Using the Media Browser .............................7
Copying to a DVD ........................................10
Creating a disc image file ............................11
Changing copy options for a DVD ....................12
DVD-Video Settings ....................................14
Changing recording settings ..........................16
Sharing recorders ........................................17
Converting video for a portable player .............18
Transferring video to other portable players ........20
Changing copy options for a portable player .......21
Troubleshooting tips ....................................22
Support options ...........................................23
What is Popcorn?

Popcorn® lets you enjoy your video anywhere you want, on the playback device of your choice, and easily make high quality copies of your DVDs and movies. Now your video will go everywhere that you do.

Popcorn includes powerful Fit-to-DVD™ compression technology that lets you fit an entire 9 GB DVD-Video onto a 4.7 GB recordable DVD. Popcorn also features award-winning Toast® burning technology, for fast and reliable copies to all major DVD formats.

System requirements

Popcorn 3 requires the following:
- Macintosh computer with PowerPC G4, G5, or Intel® processor
- Mac OS X v10.4.10 or higher
- 300 MB of free disk space to install
- Up to 15 GB of temporary free disk space
- QuickTime 7.1.6

Optional:
- DVD burner and recordable media
- Apple TV™, Video iPod®, or iPhone™
- BlackBerry® device with MPEG-4 video support
- Palm® Treo™ 680, 700p, or 755p with MPEG-4 video support
- EyeTV video recorder or Turbo.264 video encoder hardware
- Xbox 360®, PlayStation®, or PSP™
- Other portable DivX, MPEG-4, or H.264 compliant video player
Installing Popcorn

To install Popcorn:

1. If you purchased a boxed version of Popcorn, insert the installation CD into your drive. Or, if you purchased a downloadable version of Popcorn, double-click the .dmg file. The Popcorn 3 window appears on your Desktop.

2. Drag the Popcorn 3 folder to the Applications folder shown in the window.

3. Locate the Popcorn 3 folder in your Applications folder and open it. Double-click the Popcorn icon to launch the software.

4. Follow the instructions to set up Popcorn the first time.

5. You will be asked to accept the license agreement and enter a CD key. You can find the CD key in one of the following locations:
   - If you purchased a boxed version of Popcorn, your CD key is printed on the back of the CD sleeve.
   - If you purchased a downloadable version of Popcorn, your CD key is included with your purchase confirmation e-mail.

If you purchased an upgrade version of Popcorn, you may also be asked to enter your CD key from a prior version of Toast or Popcorn.
Getting to know the Popcorn window

The Popcorn main window contains the following components:

- **Video source selection area**: Choose a video source to select the type of project you wish to create:
  
  Sources for DVD Project
  
  - **DVD Disc**: Create a video file from a DVD that you can play on your Mac or portable device.
  
  - **Image File**: Create a DVD-Video disc from a DVD-Video image file.
  
  - **VIDEO_TS Folder**: Create a DVD-Video disc or DVD image files from one or more VIDEO_TS folders. If multiple VIDEO_TS folders are used as the source, DVD image files will always be created.
■ **Video Files**: Create a DVD-Video disc from individual video files.

Sources for Player Project

■ **DVD Disc**: Convert a DVD to a video file for use on your Mac or with a portable device.

■ **Image File**: Convert a DVD-Video image file to a video file.

■ **VIDEO_TS Folder**: Convert one or more VIDEO_TS folders to video files.

■ **Video File**: Convert video files to another format.

■ **Content area**: This is where the discs or video files you are copying or converting appear.

■ **Copy button**: Click this red button to begin burning or converting.

■ **Recorder or Player Settings button**: Select recorder or player settings.

### What types of video can Popcorn use?

Popcorn can copy DVD-Video to a blank recordable DVD, including:

■ DVD-Video discs created with Toast®, iDVD®, or DVD Studio Pro®

■ Commercial DVD-Video discs that are not copy-protected or encrypted

■ DVD-Video image files or VIDEO_TS folders from your hard disk

Popcorn can convert DVD-Video and other video files for use on portable players, including:

■ DVD-Video discs created with Toast®, iDVD®, or DVD Studio Pro®

■ Commercial DVD-Video discs that are not copy-protected or encrypted

■ DVD-Video image files or VIDEO_TS folders from your hard disk

■ Native QuickTime file formats, such as DV, AVI, MOV, and MPEG-4

■ Other non-QuickTime file formats, such as MPEG-2 and DivX
To copy a DVD-Video or video file to a blank DVD, see Copying to a DVD on page 10.

To convert a DVD-Video or other video file for use on an iPod, iPhone, Apple TV, or other device, see Converting video for a portable player on page 18.

**Popcorn Extras**

Popcorn includes additional applications to help you save, share, and enjoy your digital media. They can easily be accessed from the Extras menu.

**Disc Cover RE Disc Labeling Software**

Disc Cover RE creates stunning disc labels and case covers for printing or laser-etching to LightScribe-enabled drives and media. For more information on LightScribe, visit http://www.lightscribe.com.

**TiVoToGo for Mac**

Transfer recorded television shows to your Mac from a TiVo Series 2 or other TiVoToGo-compatible DVR connected to your home network. Watch them on your Mac, burn them to a DVD, or convert them for viewing on an iPod, PSP, or other device. For more information on TiVoToGo for Mac, visit: http://www.roxio.com/enu/support/popcorn/tivo/.
Using the Media Browser

The Media Browser provides quick access to video stored on your computer. You can easily drag and drop content from the Media Browser into the Content Area.

To use the Media Browser:

1. Open the Media Browser window by choosing Window > Show Media Browser, or press Ctrl+S.

2. From the Media Type pop-up menu, choose the type of media you want to browse:

   - **Movies**: Browse videos and iMovie projects in your Movies folder.
   - **EyeTV**: Browse recorded TV shows from EyeTV. This option is only visible if you have EyeTV digital television recorder software installed (see www.elgato.com for more information).
   - **TiVo**: Browse recorded TV shows that have been transferred from your TiVo. This option requires a TiVo® DVR that supports TiVoToGo™ (see www.tivo.com).
■ **DVD**: Browse non-encrypted DVD-Video discs, mounted disc images, or VIDEO_TS folders located on your Desktop or in your Movies folder.

**Note** You can also access discs from set-top DVD recorders or DVD camcorders. Popcorn includes special support for these discs, which normally are not usable in the Mac OS. Insert these discs in your recorder while Popcorn is running, and then import video from them with the Media Browser.

■ **File Browser**: Browse files and folders on your local hard disk, external discs, or connected network volumes.

■ **Spotlight**: Search for files or folders by entering a search term in the text field at the bottom of the Media Browser window.

When browsing movies or DVDs, you can filter the media list by choosing a folder or specific DVD, title or chapter from the second pop-up menu.

**Note** When the File Browser is selected, the second pop-up menu allows you to navigate folders on your system. When Spotlight is selected, the second and third pop-up menus allow you to narrow your search to a specific location or media type.

4 Select any item in the file list and drag it to the Content Area to add it to a project, or click the **Add** button at the bottom of the Media Browser.

You can select multiple items by holding down the **Command** (Apple) key while clicking, and then drag the entire selection to the Content Area.

You can select groups of items by clicking on the first item in the group and then holding down the **Shift** key while clicking on the last item in the group, and then drag the entire selection to the Content Area.

You can preview most media files by double-clicking them in the file list or by clicking the **Preview** button at the bottom of the Media Browser.
Popcorn will display progress information while the items are being added. If the content is being added from a disc (such as from a set-top DVD recorder) this may take several minutes, as it is imported from the disc onto your hard disk.

Imported items from a disc are temporarily stored in the Roxio Converted Items folder in your Documents folder and can be very large. The original source content is not deleted from your disc.

You can configure when Roxio Converted Items is emptied through Popcorn’s preferences, which can be accessed by choosing Popcorn > Preferences.
Copying to a DVD

This section explains how to copy a DVD-Video disc, disc image file, valid VIDEO_TS folder, or video files to a blank recordable DVD disc for playback in a DVD player. Popcorn can copy non-encrypted DVD-Video content.

To learn more about DVD-Video, refer to: http://www.dvddemystified.com/dvdfaq.html.

To convert a DVD-Video or other video file for use on an iPod, iPhone, Apple TV, or other device, see Converting video for a portable player on page 18.

To copy to a DVD:

1. Launch Popcorn and select a video source in the DVD project area.
   - Choose **DVD Disc** to copy a DVD-Video disc in your DVD drive. If you choose this option, insert the original DVD-Video disc into your DVD drive.
   - Choose **Image File** to copy a DVD-Video disc image file from your hard disk. If you choose this option, drag a disc image from your hard disk into the content area.
   - Choose **VIDEO_TS Folder** to copy a valid VIDEO_TS folder from your hard disk. If you choose this option, drag a VIDEO_TS folder from your hard disk into the content area.
   - Choose **Video Files** to copy video files to a DVD. If you choose this option, drag video files from your hard disk or Media Browser to the content area.

2. A summary of the content that will be copied appears in the content area. In the case of video files, each of your video files will be listed.
   - If your DVD-Video source is greater than 4.7 GB in size, a message in the Summary area indicates that automatic compression may be needed. After you insert a blank DVD, Popcorn determines if you are using single-layer or dual-layer media. If you are using a 4.7 GB single-layer disc, Popcorn will compress your video to fit onto the disc. If you are using an 8.3 GB dual-layer media, no compression will occur.
To copy the entire DVD-Video source, including all menus, video and audio, proceed to Step 3.

You can optionally choose to include or exclude specific video, audio and languages. Removing this extra content reduces the amount of compression required and maximizes quality and available disc space. To learn more, see Changing copy options for a DVD on page 12.

3 Click the large red Copy button, choose a recorder from the list, and click Record to continue.

Note: You can use the same recorder to read the source DVD and burn to the blank DVD. Popcorn will copy the original disc to a temporary location on your hard disk.

You can optionally choose recording settings, such as Number of Copies. To learn more, see Changing recording settings on page 16.

4 When prompted, insert a blank DVD-recordable disc.

Popcorn displays a progress bar as it records your disc.

**Creating a disc image file**

Instead of copying to a DVD-recordable disc, you can create a disc image file and store it on your hard disk. You can copy this image to disc or mount it and view the contents at a later time.

**To save a disc image file:**

1 Start to copy as you normally would, as explained in Copying to a DVD on page 10.

2 Instead of clicking the red Copy button, choose File > Save As Disc Image.

   The Save Disc Image dialog appears.

3 Enter a name in the Save As field and browse to the location on your hard disk where you want the disc image file to be saved.

4 Click Save to continue.
A dialog box may appear asking whether you want to create single-layer or double-layer discs from the image file. The best choice depends on the type of drive you have, your plans for the image file and the size of its contents. If you choose double-layer, compression will be minimized, but the file may not fit on a single-layer disc. If you choose single-layer, compression will be set automatically to the level needed to fit the contents on a single-layer disc. Choose the option that best meets your needs.

To copy this disc image at a later time, see *Copying to a DVD* on page 10.

**To mount an image file:**
- Control-click on the image file and choose **Mount It** from the menu.
  Mounted images behave like an actual physical disc inserted into your DVD drive and appear on the Desktop.

**To unmount an image file:**
- Drag the disc icon to the Trash in the Dock.

**Note** Do not drag the disc image file to the Trash unless you want to delete the image file from your hard disk.

### Changing copy options for a DVD

Fit-to-DVD compresses video to fit on a standard 4.7 GB recordable DVD. Compression may result in a slight reduction in video quality, but will leave the audio quality unchanged. By default, the entire disc is copied, with all menus, video, and audio. You can choose to exclude specific video, audio, and languages. Excluding unnecessary content reduces the amount of compression required and maximizes quality and available disc space.

**To change copy options:**
1. After launching Popcorn and selecting a DVD project, click **Fit-to-DVD video compression** and add your source to the Content Area.
2 Click Copy Options.

3 Select the Video pop-up and choose the video to include:
   - All: Select to include all video. All menus will be included.
   - Main: Select to include only the single-longest running video. Menus will not be included.
   - Custom: Select to choose the specific videos to be included. Menus will not be included.

   **Note** If you choose Main or Custom, the copied disc will not have a menu, but the first video will play automatically when the disc is inserted. If the disc contains multiple videos, all videos will play continuously, in sequence. You may be able to use the Title menu in your DVD player to select a video.

If the Apple DVD Player software is installed on your Mac, you can preview a video by clicking on the small play button on the thumbnail of the video.

4 Select the Audio pop-up and choose the audio to include:
   - All: Select to include all audio for each video.
   - Main: Select to only include the primary audio for each video (typically the highest quality Dolby Digital). Secondary audio, such as director’s commentary, or other audio formats such as PCM or DTS® audio will be excluded.

   **Note** If you have set the Video option to Custom, the Audio pop-up does not appear. Instead, you will be able to select Audio and Language options for each video.
Note  When you remove audio or languages, the audio setup menu and secondary audio on the copied disc may not behave as expected. The main video and audio should continue to operate as expected. To ensure best results, choose All.

As you make selections, the amount of compression needed and the video quality indicator change. If you choose to only include the main movie or reduce the number of languages and audio, the indicator shows improved quality for the resulting DVD.

5  Click OK to continue and proceed with your copy.

**DVD-Video Settings**

The options shown below are only available when you are creating a DVD-Video disc using video files as source.

With improvements in the latest version of Popcorn, a standard DVD-Video disc can hold approximately 240 minutes (4 hours) of video as well as Dolby Digital sound and full menu navigation. If your recorder supports dual-layer recordable DVDs, you can create a DVD-Video with approximately double this amount of content.

**To make a DVD-Video:**

1  Launch Popcorn and select Video Files in the DVD project area.

2  Add your video files to the project area by dragging video files from your hard disk or Media Browser to the content area.

3  Choose optional disc settings:

   - **Automatic Encoding**: Choose this option to use all video and audio encoding settings that maximize quality and fit the most content on the disc. Variable bit rate encoding is used for video, Dolby Digital 192 Kbps is used for audio, and aspect ratio is determined automatically from the source videos.
- **Custom Encoding**: Choose this option to manually set video and audio encoding options. Click on the current settings to modify them.

- **Video Quality**: Popcorn must compress video to fit onto the DVD. Choose the quality you want. Better quality takes longer to process.
  - **Good**: Suitable for simple video, such as people talking – fastest processing time.
  - **Better**: Suitable for most video – average processing time.
  - **Best**: Suitable for complex video, such as fast motion – lowest processing time.

- **Menu Style**: Choose the style for the menu background image, text, and buttons.

- **Auto-Play disc on insert**: Select this option to automatically play the first video or slideshow when this disc is inserted into a DVD player. The DVD main menu is not displayed, but is accessible by choosing the Menu button on the DVD player remote control. Some players may not support Auto-Play.

- **Play all items continuously**: Select this option to automatically play each video or slideshow on the DVD without first returning to the DVD’s main menu.

Additional options are available by clicking the More button.
Changing recording settings

You can view or change your recording settings, such as which recorder to use, number of copies to record, or what Popcorn does after recording is complete.

To change recording settings:

1. Click the **Recording Settings** button, and select **Recorder Settings** from the menu that appears.

2. Click the **Basic** tab. You can change basic recording settings, including:
   - **Recorder**: Select the recorder you want to use.
   - **Write Speed**: Select the recording speed. By default, Popcorn will use the best speed, which is the fastest speed that your recorder and the blank media both support. For example, if your DVD recorder supports 1x, 2x, 4x, and 8x, and the blank disc only supports 1x and 2x, then Popcorn will record at 2x speeds. To choose a specific write speed, first insert the blank disc into your recorder. After a few seconds, the pop-up will list all speeds available for your recorder and the current blank media.
   - **Number of Copies**: Enter the number of copies of the disc you want to make. Popcorn will prompt you for blank discs after each copy.

3. Click the **Advanced** tab. You can change advanced recording settings, including:
   - **After Writing**: Select what you want to do with the disc after recording it. Popcorn can mount the disc on the desktop, eject the disc, or prompt you for either.
   - **Buffer Underrun Prevention**: Select this check box to turn on buffer underrun prevention. A buffer underrun error occurs when your hard disk is unable to send data fast enough to the recorder while recording, causing the blank disc to be unusable.
This option is available only if your recorder supports buffer underrun prevention, and should be used for best results.

- **Display Recorder Settings Before Writing**: Select this check box if you want to display the Recorder Settings dialog each time you click the red Copy button.

4 Click **OK** when you are finished.

## Sharing recorders

Popcorn includes ToastAnywhere™ recorder sharing technology, which lets you record to an available DVD recorder from Toast users on your local network.

**To use a shared recorder:**

1 Click the red **Copy** button.

2 In the Recorder Settings dialog, choose a recorder from the list and click **Record** to continue.

---

**Note** This list contains recorders connected directly to your system and any shared recorders from Toast users on the same local network.

3 The person using the computer with the shared recorder you have selected will be prompted to insert a blank disc.

Popcorn displays a progress bar as it records your disc over the network.
Converting video for a portable player

This section explains how to export and convert a DVD-Video or other video file into a format for use on portable devices including iPod, iPhone, DivX players, and more.

Once Popcorn has converted video to the correct format for your device, such as MPEG-4, H.264, or DivX, you can then transfer it to your player.

To copy a DVD-Video to a blank recordable DVD, see Copying to a DVD on page 10.

To convert video for a portable player:

1. Launch Popcorn and select your video source in the Player project area:
   - Choose DVD Disc to convert a DVD-Video disc in your DVD drive. If you choose this option, insert the original DVD-Video disc into your DVD drive.
   - Choose Image File to convert a DVD-Video disc image file from your hard disk. If you choose this option, drag a disc image from your hard disk into the content area.
   - Choose VIDEO_TS Folder to convert a valid VIDEO_TS folder from your hard disk. If you choose this option, drag a VIDEO_TS folder from your hard disk into the content area.
   - Choose Video File to convert one or more individual video files from your hard disk. If you choose this option, drag and drop the video files from your hard disk or Media Browser into the content area. You can add any QuickTime supported video files, such as DV, AVI, and MOV. You can also add files that QuickTime doesn’t support such as MPEG-2 and DivX. If you add multiple files, Popcorn will convert them in batch mode.

A summary of the information that will be converted appears in the content area.
If you are converting a DVD-Video source, you can choose which audio and video to include. By default, the main video and audio are included. To learn more, see *Changing copy options for a portable player* on page 21.

2 Click the large red **Copy** button and choose your player settings.

3 Complete the following steps:
   a Choose a Device from the pop-up list that most closely matches your player. If your specific device is not listed, choose DivX, MPEG-4, or H.264 Player.
   
   b Choose a quality level from the pop-up list. You will see a summary of the video and audio settings for the quality level you select. If you are unsure that you have selected the correct quality, you can play back a small preview to see how your converted video will look before beginning the full conversion.

   c Optionally choose a Save To destination from the pop-up list. If you are exporting to your iPod, iPhone, or Apple TV, you should keep the default iTunes choice.

4 Click **Convert** to continue.

Popcorn displays a progress bar as your video is converted. Encoding can be paused at any time to free up the CPU for other tasks and then resumed later. When encoding is paused, you can run other applications or even switch to another user account as long as Popcorn remains open. If you close the Popcorn application, even when video encoding is paused, you must restart the process from the beginning.

---

**Note** Apple TV users converting DVD content can convert their video with Dolby Surround (Pro Logic) support. The Apple TV must be connected to a Pro Logic II receiver to take advantage of this feature.
Note Popcorn now supports Elgato Turbo.264 to accelerate H.264 encoding. You must have the Turbo.264 video encoder hardware connected to a USB port on your Mac before beginning your project. See www.elgato.com for more information.

Transferring video to other portable players

For detailed instructions on how to transfer video to portable devices and players that support DivX, MPEG-4, or H.264, refer to the documentation included with the device. In many cases, these devices can be connected to your Mac via a USB cable or card reader, and will appear on your Desktop so you can copy the converted files onto them.
Changing copy options for a portable player

If you are converting a DVD-Video source for a portable player, you can choose which audio and video to include. Although some video on a DVD-Video may contain multiple audio tracks and languages, when converting this video for a portable player, only one audio track can be selected. By default, the main video and audio are included.

To change the conversion options:

1. In the content area, click Options.

2. Select the Video pop-up:
   - Choose All to include all video.
   - Choose Main to only include the single longest running video.
   - Choose Custom to select individual videos.

   If the Apple DVD Player software is installed on your Mac, you can preview a video by clicking on the small play button on the thumbnail of the video.

   By default, the primary audio is automatically selected for each video. If you select Custom as your Video choice, you can choose a different audio option for each video.

3. Click OK to continue and proceed with your copy.
Troubleshooting tips

If you receive errors while recording using Popcorn, try any of the following tips to resolve the problem:

- Save your project as a disc image file on your hard disk. After you create the image file, you can copy it to a disc.
  
  For more information, see Creating a disc image file on page 11.

- Make sure that your computer is not going to “sleep” before Popcorn’s compression process is completed. Adjust the Sleep options in the Energy Saver System Preference.

- Burn at a slower speed. In the Recording Settings dialog, choose “1x” as the Write Speed. If the disc burns successfully, try choosing “2x” the next time, then “4x,” and so on.

- Try a different brand of blank DVDs. Make sure to use reliable media from a leading manufacturer.
  
  See http://www.nomorecoasters.com for suggestions.

- Try a different recorder. If your recorder is consistently giving errors, it may be failing. Choosing a different recorder may give better results.

- Try running fewer applications on your computer while burning.
  
  Avoid processor-intensive tasks while burning.

- Do not modify the source files while preparing the disc or recording it.
  
  For example, do not move or rename the files.
Support options

Unlimited self-help options
Roxio provides a variety of self-help tools, including our virtual agent, a searchable knowledge base of support articles with troubleshooting tips, and discussion forums with other users that can help you get the most out of your Roxio products.

You’ll find answers to most of your questions at http://support.roxio.com, or you can choose Help > Product Support from within Popcorn.

Alternate support options
Alternate support options such as e-mail or telephone support may be available on a limited or paid basis for your Roxio product. Please visit our Web site at http://support.roxio.com to find out what options are available for your product.

Contacting Roxio
Log in to our Customer Web portal to submit a request for assistance or to find support contact information for your location.

You can find the customer Web portal at http://selfserve.roxio.com.